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Introduction

NCSA Telnet for the Macintosh® Version 2.6 provides interactive access from a Macintosh to 
telnet hosts on TCP/IP networks. NCSA Telnet is an implementation of DARPA standard telnet. 
You can have simultaneous connections to numerous computers across the network, and a standard
file transfer (FTP) server lets you transfer files to and from other remote machines and users.

This introduction presents an overview of the capabilities and features of NCSA Telnet for the 
Macintosh. The organization and use of this manual are described and notational conventions 
explained.

Special Features

Special features of NCSA Telnet include:

VT102/VT220 emulation
FTP client
File transfer server (standard FTP)
Simultaneous telnet connections to a number of computers
Tektronix 4014 and 4105 emulation
Color raster graphics capabilities
Domain name lookup using MacTCP
Scrollback with ability to print and copy
User-defined macro keys
Customized window arrangement facility
Support for window contents of fewer or greater than 24 lines
Support for any font, font size, or color
Line-mode support (RFC 1184)
Encrypted telnet sessions
Authenticated telnet sessions

Differences between NCSA Telnet 2.5 and NCSA Telnet 2.6

The following are the features added in the 2.6 version:

Encrypted sessions
Authenticated sessions
Support for the Cornell Kerberos driver
Support for Translation Tables
Graphical configuration
Support for PAGE UP, PAGE DOWN, HOME, and END keys
EMACS mode for arrow keys
MacBinary II support
Resizeable TEK windows
VT printing escape sequence support
Support for "CDUP" FTP server command
Optional inhibiting of TEK emulation
Two paste modes, "quick" and "block"
Directly specified answerback message
Xterm "Change Window Title" sequence support
Telpass functionality integrated into NCSA Telnet
Default transfer directory for each FTP user
Optional FTP ISO translation
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2 ➢ NCSA Telnet for the Macintosh®
User modification of default filetype and creator type for binary files
User modification of creator type of text files
Change window title

The following are the features from NCSA Telnet 2.5 that are no longer available in the Version 
2.6:

Serial Connections
SLIP Connections via built in drivers
The NCSA TCP/IP drivers

Upgrade notes for NCSA Telnet 2.5 users

The most important difference between NCSA Telnet 2.5 and NCSA Telnet 2.6 is the removal of 
all external configuration files. All of the parameters of NCSA Telnet 2.6 can and must be 
configured from within the application. NCSA Telnet 2.6 maintains all of its configuration in the 
file "NCSA Telnet Preferences," which is stored in the Preferences folder of your System folder. 
This file is not in a user editable format. Although the config.tel file is no longer required, it is 
recommended that you retain a copy in the event you have to use an older version of NCSA Telnet.

Bugs fixed from NCSA Telnet 2.5

Many of the bugs present in NCSA Telnet 2.5 have been corrected in the 2.6 version. The bugs and
problems that have been fixed include:

"Next Session" unnecessarily redrawing windows
Dropped connections ignoring don’t go away option
Several memory leaks

System Requirements

To run NCSA Telnet for the Mac Version 2.6, you need a Macintosh with System software version 
6.0 or later and MacTCP.

Installation Note

This manual assumes that NCSA Telnet for the Macintosh® Version 2.6 has been installed on your
system by a system or network administrator who has assigned an IP address to your Macintosh.

Using This Manual

This section describes the scope and organization of this manual as well as the conventions and 
nomenclature used in developing it.

Before using NCSA Telnet for the Macintosh, you should know how to use the mouse, issue 
commands from menus, work with windows, and locate files using directory dialog boxes. If you 
are unfamiliar with the Macintosh user interface or need more detailed information regarding these
procedures, please refer to your Macintosh user's guide.

Manual Contents
This manual is organized into the following chapters and appendices:

Chapter 1, "Getting Started," introduces the basic steps in using NCSA Telnet for the Macintosh: 
starting the program; opening and closing connections to a remote host; setting a terminal 
type; emulating the VT keyboard; copying, pasting, and printing; and quitting the program.
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Chapter 2, "Configuration," describes changing the configuration settings, setting the 

characteristics of connection windows, using saved sets, defining macros, and customizing 
other NCSA Telnet operations.

Chapter 3, "Advanced Features," discusses working with multiple connections, telnet options, 
configuring authentication and encryption, and network-related commands.

Chapter 4, "File Transfer," explains how to transfer files between a Macintosh and any FTP host 
on the network.

Chapter 5, "Tektronix 4014 and 4105 Emulation," describes how to use the graphics capabilities 
of NCSA Telnet.

Chapter 6, "Interactive Color Raster Graphics," introduces the Interactive Color Raster (ICR) 
protocol and describes how you can use it to display color graphics with NCSA Telnet.

Appendix A, "Error Conditions," describes some of NCSA Talents error messages as well as their 
causes and solutions.

Appendix B, "VT Compatibility and Escape Sequences," contains information regarding NCSA 
Telnet’s implementation of the VT series of terminals.

Appendix C, "Obtaining NCSA Software," describes how to get NCSA software via an 
anonymous FTP server, an archive server, or U.S. Mail.

Notational Conventions Used in This Manual
Material in this manual is presented in text, screen displays, or command-line notation. Different 
typefaces indicate different functions.

New concepts or terms are generally in italic type when they first occur in text to indicate that they are 
defined in the paragraph.

Cross references within this manual usually include the title of the referenced section or chapter 
enclosed in quotation marks (e.g., see Chapter 1, "Starting Quitting NCSA Telnet").

Boldface type represents characters you enter as shown (literal expressions).

Lowercase italic type represents a variable, a placeholder for the text you actually enter. A variable
can consist of different characters each time you make the entry.

Throughout this manual, you may be instructed to enter specific characters on the keyboard. These
entry instructions (command lines) are printed in Courier boldface type (e.g., dothis) and appear 
either within a paragraph or on a separate line. Command lines are normally entered in lowercase.

Helvetica boldface type (e.g., the Cancel button) represents boxes and buttons in dialog boxes, 
command names on pull-down menus, and menu names.

Keys that are labeled on your keyboard with more than once character, such as the RETURN key, 
are identified by all uppercase letters in normal font. Keys that you are to press simultaneously or 
in succession are linked with a hyphen (e.g., press SHIFT-OPTION-d).
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Getting Started

This chapter introduces and describes the basic steps involved in using NCSA Telnet for the 
Macintosh® Version 2.6:

invoking the program
opening and closing a telnet connection
copying, pasting, and printing the contents of session windows
exiting the program

The chapter assumes that your system or network administrator has already installed NCSA Telnet 
on your system, assigned an IP address to your Macintosh, and given you a login name and 
password for the computer to which you want to connect. For information regarding installation 
and customization procedures, refer to Chapter 2, "Configuration."

It is also assumed that you already know how to click and drag using the mouse, move and resize 
windows, and select items from menus. If you are unfamiliar with the Macintosh user interface or 
need additional information regarding these procedures, please refer to your Macintosh user's 
guide.

Beginning a telnet Session

Invoke NCSA Telnet by double-clicking on the NCSA Telnet file or application icon. The NCSA 
Telnet application icon is shown below:

A "splash box" introducing NCSA Telnet appears on your screen, then disappears.

Opening a Connection
To open a connection to a host:

Select Open Connection from the File menu:

The Connection modal dialog box appears.

Fill out the Connection dialog box. In the Host/Session Name box, enter the name of the host to 
which you want to connect. The session name can be any hostname, IP address, or an alias. 
You may optionally append an alternate port number to connect 
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to after the hostname, IP address, or alias. In the sample below, the hostname is pluto:

In the Window Name box, you may enter any name you wish for the connection’s window. This 
optional feature is not necessary with single connections but is very useful when you open multiple 
connections. If you do not specify a window name, the connection’s window title will be set to the 
contents of the Host/Session Name box, with a number appended.

If you want to connect as an FTP client, click the FTP Session box in the Connection dialog box. 
For information regarding the FTP client, see Chapter 4, "File Transfer."

If you want to start an authenticated or encrypted connection, click the Authenticate box in the 
Connection dialog box. Authenticate must be checked if you wish to use encryption. For 
information regarding authentication and encryption, see the section "Authentication and 
Encryption," in Chapter 3, "Advanced Features."

Click the Connect button in the Connection dialog box, or press the RETURN key on your 
keyboard.

NCSA Telnet attempts to connect to the host you specify, a process that generally takes only a few 
seconds. When a connection is established, a connection window appears. The Window Name you 
specify in the Connection dialog box appears both in the title bar of the connection window and in 
the Connections pull-down menu.

For alternative ways to open a connection, for session names other than the hostname, and for a 
discussion of aliases, see Chapter 2, "Configuration." For working with multiple sessions, see 
Chapter 3, "Advanced Features."

Logging on to Your Host
The connection’s window indicates the name and type of your host machine and prompts you to 
enter your login name. For example, if you attempt to connect to a Sun system dubbed pluto, the 
login prompt may look like this:

SunOS UNIX (pluto)

login:

To log on:

Enter your login name at the login prompt and press RETURN. The host prompts you to enter your
password.

Enter your password and press RETURN.

From this point on, NCSA Telnet operates as a VT102 or VT220 terminal remotely connected to 
the host.

NOTE: The response time of a host can vary. If the remote host is heavily loaded, a few minutes 
may elapse after the connection opens before the host prompts you to log on.

Setting the BACKSPACE/DELETE Key
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6 ➢ NCSA Telnet for the Macintosh®
NCSA Telnet automatically translates BACKSPACE/DELETE keypresses into delete codes, for 
compatibility with systems that prefer delete to backspace. If your backspaces are not accepted, the
host you are using may accept only backspace codes.

To test this possibility, follow the instructions below to change the setting of the 
BACKSPACE/DELETE key to backspace. This steps reset the default translation so that the key 
sends a backspace code. If your backspaces are now accepted, the host prefers backspace codes.

To change the setting of the BACKSPACE/DELETE key, select the desired keycode to be sent 
(BACKSPACE or DELETE) from the top of the Session menu. For more information regarding the
configuration of the BACKSPACE/DELTE key, see the section "Session Configuration Records" 
in Chapter 2, "Configuration."

Setting a Terminal Type
NCSA Telnet can emulate a VT102 or VT220 terminal. When you log on to a host, the host 
operating system does not always know what type of terminal you are using. For instructions on 
setting terminal type, consult the operating system manual for the host you are using.

Try setting the terminal type to VT100 or VT102. For systems that do not support VT102 (such as 
many UNIX systems), use VT100 or tab132 (which is compatible with VT102 emulators).

The following examples show how to set the terminal type for two popular operating systems and 
hosts, UNIX (using the C shell) and VAX/VMS.

For UNIX operating system using a C shell and VT100 terminal type:

pluto% set term=vt100;tset

For UNIX operating system using a C shell and VT220 terminal type:

pluto% set term=vt220;tset

For VAX/VMS operating system:

B$ set term /inq

Emulating the VT Terminal keyboard
When NCSA Telnet is running, your Macintosh appears to the host as a VT series terminal. 
Keystrokes for keys common to the Macintosh and VT series keyboards are transmitted by NCSA 
Telnet without modification. However, the VT series keyboard has some keys that the Macintosh 
keyboard does not have and also treats or labels other keys differently. In addition, many VT series
keys have special meanings when they are transferred to the host.

You can use the Macintosh keyboard to provide full VT220 functionality. Macintosh key 
commands that correspond to key commands on a VT series terminal are listed below. Note that 
the numeric keypad on the Macintosh is identically positioned to that of the VT series terminal, 
although the labels differ. If you are accustomed to using a VT series keypad, you can ignore the 
Macintosh labels and enter as usual.

VT Series Key          Macintosh Plus Keyboard     Apple Desktop Bus Keyboard
Backquote-             -Backquote†   -            -Backquote† 

                      OPTION-Backquote            OPTION-Backquote†
ESC††                  Backquote                   ESC or Backquote
DELETE†††              BACKSPACE                   DELETE or DEL
BACKSPACE†††-          OPTION-BACKSPACE            OPTION-DELETE
LINE FEED              CONTROL-J                   CONTROL-J
PF1                    CLEAR on keypad             CLEAR on keypad
PF2                    / on keypad                 / on keypad 
PF3                    = on keypad                 = on keypad
PF4                    * on keypad                 * on keypad
CONTROL-SPACEBAR(NUL)  OPTION-SPACEBAR             CONTROL-SPACEBAR
Keypad keys            Keypad keys                 Keypad keys
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†    Using -Backquote is necessary if the "Remap Backquote to ESCape" option is on.

††   Use of the Backquote key as ESC is governed by the setting of the 
    Remap backquote to ESCape option in the Global Preferences modal dialog box.
†††  See the discussion of the BACKSPACE/DELETE key above.

For more information regarding NCSA Telnet’s emulation of the VT series of terminals, refer to 
Appendix B, "VT Compatibility and Escape Codes," and Chapter 2, "Configuration." Information 
regarding the VT220 function keys can also be found in Appendix B.

Closing a Connection
To close a connection to your host, use the logout procedure specific to that system. For example, 
on a UNIX system you enter the UNIX logout command at the command-line prompt:

pluto% logout

If you cannot log out in this manner, select Close from the File menu. A Close Connection modal 
dialog box appears on the screen to confirm that you want to forcibly close the connection.

 

Click on the OK button in the dialog box or press the RETURN key on your keyboard. 

After you log out, the connection’s window disappears. You can now safely quit the NCSA Telnet 
application.

Copying, Pasting, and Printing

NCSA Telnet lets you copy, paste, and print the contents of your connection windows. Before 
doing any of these operations, first select (highlight) a region of text from the window.

To copy highlighted text of a window as is, choose Copy from the Edit menu.

To copy highlighted text of a window as a table, choose Copy Table from the Edit menu. White 
spaces in the highlighted text are replaced by tabs, according to the setting of the Copy Table 
Threshold in the Global Preferences dialog box, so you can paste the table into a word-processing 
program such as Microsoft Word or into a spreadsheet program such as Microsoft Excel.

To paste the contents of the Clipboard into a session window, choose Paste from the Edit menu.

To print highlighted text:

Choose Page Setup from the pull-down File menu, specify the desired printing parameters in the 
Print dialog box that appears, and click the OK button in the dialog box or press the RETURN
key on your keyboard.

Choose Print Selection from the File menu. Specify the number of copies, printer feed, and other 
parameters in the Print dialog box that appears, then click the OK button or press the 
RETURN key on your keyboard.

For more information regarding the Page Setup or Print dialog boxes, refer to your Macintosh 
user's guide.
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NOTE: Copying and pasting are also discussed in Chapter 5, "Tektronix 4014 and 4105 
Emulation," and Chapter 6, "Interactive Color Raster Graphics." The Copy Table Threshold settings
are discussed in the "Global Preferences" section of Chapter 2, "Configuration."

Quitting NCSA Telnet

To exit NCSA Telnet, select Quit from the File menu.

NOTE: NCSA Telnet for the Mac lets you quit the application at any time during the program's 
execution; however, to avoid loss of data or other complications, whenever possible you should 
close connections to each system before quitting NCSA Telnet. If you do attempt to quit the 
application before closing current connections, a dialog box appears to confirm that you want to 
forcibly close the connections. If you do, click the OK button in the dialog box or press the 
RETURN key on your keyboard; if you do not want to forcibly close connections, click the Cancel 
button in the dialog box.
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Configuration

NCSA Telnet for the Macintosh® allows you to customize the environment to suit special needs 
and habits. This chapter describes the configuration system used by NCSA Telnet for sessions, the 
use of saved sets, and the several global preferences.

Configuration of the file transfer related services is described in Chapter 4, "File Transfer."

Configuration Overview

NCSA Telnet has several preference options that effect every session or the operation of NCSA 
Telnet in general. Those preferences are described in the section "Global Preferences."

NCSA Telnet 2.6 utilizes an entirely new configuration system. Previously, NCSA Telnet required 
an external text file named config.tel. That file contained several keywords that specified the user’s
preferences. The configuration system for NCSA Telnet 2.6 is entirely graphical in nature and does
not require any external user-editable files.

Connection Preferences System Rationale and Overview
NCSA Telnet’s configuration system for connections is comprised of two parts, "Sessions" and 
"Terminals". Ideally, all of the configuration options for a connection would be combined into one 
entity. However, due to the great number of options for each connection, the options have been 
divided into the aforementioned categories. The "terminal" configuration record contains the 
options that pertain primarily to the terminal emulation done by NCSA Telnet. The "session" 
configuration record contains the remaining options. Each session configuration record has a 
terminal configuration record associated with it. The terminal record associated with a given 
session record is entirely up to the user.

The <Default> Session and Terminal Configuration Records
The <Default> terminal and session configuration records are set to reasonable defaults when 
NCSA Telnet is launched for the first time. The user may change the preferences in the <Default> 
records, but the <Default> records may not be deleted.

The <Default> session and terminal records are used when the user enters a hostname in the open 
connection dialog box. The preferences contained in the <Default> records are used as the defaults
for any connection that does not have a preconfigured session or terminal record. The <Default> 
records are also used to set the initial values of any new terminal or session configuration records 
the user may define.

Global Preferences
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To edit the Global Preferences, select Global from the Preferences submenu of the Edit menu. A 

modal dialog box will appear:

Each of these options are described in the following sections.

Command Keys
When Command Keys is checked, the menus are configured to accept command key equivalents.

Note: When NCSA Telnet is running on a Macintosh that has no control key, NCSA Telnet will 
remap the  key to the  control key if Command Keys is not checked. If Command Keys is checked 
on such machines, the user will have no way to generate control key characters.

Remap Backquote to ESCape
When Remap backquote to ESCape is checked, NCSA Telnet sends the ESCape character to the 
remote host when the ` key is pressed. This is useful for users with the original Macintosh or 
Macintosh Plus keyboards. This option, however, is available to users regardless of their keyboard 
type. Pressing -` will always produce a backquote character, regardless of the setting of this 
option.

Copy Table Threshold
The Copy Table Threshold value determines the number of spaces which, at a minimum, are 
replaced by tabs when the user issues the Copy Table command from the Edit menu or press -T. 
Instead of using the standard Copy command, the user can use the Copy Table command to copy 
tables of data from the NCSA Telnet screen onto the Clipboard.

When the user uses the Copy Table command, all strings of contiguous spaces that are greater than 
the threshold are turned into tabs before being placed on the Clipboard. This produces a format 
that can be pasted into most spreadsheet and graphing programs without losing data or requiring 
additional formatting.

Timeslice
The Timeslice value determines how much time NCSA Telnet gives to other applications that may 
be running. Increasing this value reduces NCSA Telnet’s responsiveness, but improves the 
performance of the applications in the background. The value is measured in sixtieths of a second.

Windows Don’t Go Away
When Windows Don’t Go Away is checked, session windows remain open after their associated 
connections have terminated. The window title is placed within parenthesis to signify that the 
associated connection has closed. To close such a window, click in the window’s close box, or 
select Close from the File menu.
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This feature allows the user to view, copy, and print text that is in a window whose connection has 
been closed. It is also useful for reading connection error messages that occur with hosts which 
may close connections immediately after they are established due to an error.

Staggered Windows
When the user selects the Staggered Windows option, the program staggers multiple windows by a 
whole title bar, allowing the user to see each window’s title. Otherwise, NCSA Telnet only staggers
each new window by a few pixels.

Blink Cursor
If Blink Cursor is checked, NCSA Telnet periodically blinks the cursor present in session windows.

Cursor Selection
Clicking the appropriate radio button: block, underscore, or vertical bar selects the type of cursor 
used by NCSA Telnet for the cursor present in session windows.

Capture File Creator
Every file on the Macintosh has a filetype and file creator type. The filetype specifies the type of 
file (e.g. text file, word processing document, saved set). The file creator type tells the Finder 
which application to launch when a user double-clicks on a file. NCSA Telnet lets the user specify 
the creator type given to the files in which NCSA Telnet saves captured text from sessions. If the 
user knows the four letter creator type for the application the user wishes to specify, type it in the 
Capture File Creator field. If the user does not know the four letter creator type, click the Select 
Application button. NCSA Telnet will present the user with a standard open file dialog box. Double
click on the application the user wishes to find the creator type for. NCSA Telnet will then enter 
the four letter creator type in the Capture File Creator field for the user.

Editing Session or Terminal Configuration Records

When the user selects Terminals or Sessions from the Preferences sub-menu of the Edit menu, a 
modal dialog box similar to this one will appear:

To add a new session or terminal, click on New. To change an existing terminal or session record 
click on Change. To remove an existing terminal or session record click on Remove. The <Default>
records can not be removed.

Session Configuration Records
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When the user creates a new session configuration record or change an existing record, 

the following modal dialog box is used:

These fields and options are described in the following sections:

Alias
The Alias field specifies the name of the session configuration record. Typing the text contained in 
this box in the Host/Session Name field of the Open Connection dialog will make NCSA Telnet use 
the configuration information contained in this session configuration record, as well as the 
information contained in the terminal configuration record specified by the Terminal popup menu 
in the session configuration record dialog box. NOTE: Spaces are not allowed in alias names.

When editing the <Default> session configuration record, the Alias field is disabled, as the 
<Default> records cannot be renamed.

Hostname
The Hostname field contains the text passed to MacTCP’s Domain Name Resolver (DNR). The 
Domain Name Resolver translates a host’s domain name into an IP address.

Port
The Port field specifies the port on which NCSA Telnet will attempt to connect to the remote 
machine.

TEK Options
There are three choices for Tektronix emulation in NCSA Telnet. Inhibit prevents NCSA Telnet 
from using any Tektronix emulation for this session. 4014 and 4105 select Tektronix 4014 
emulation or Tektronix 4105 emulation, respectively.

Paste Method
NCSA Telnet can use two different methods when pasting data into a session. If Quick is selected, 
NCSA Telnet sends all of the data to be pasted to the remote host at once. This method works well 
for small amounts of text and for sessions involving hosts that are close to the user on the network.
For pasting large amounts of text, or when the user is connected to a machine that is slow to 
respond, the Block paste method is recommended. When the Block method is selected, NCSA 
Telnet sends the data to be 
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pasted to the remote host in sections, or blocks of text. The size of the blocks is determined by the 
number entered in the field next to the Block radio button.

The Delete Key
Some hosts expect the delete character for deleting, others expect the backspace character. 
Selecting Delete or Backspace determines what character NCSA Telnet will send to the remote host 
when the user presses the DELETE character on the user’s keyboard.

Forcesave
Forcesave forces NCSA Telnet to always save the contents of the screen to the scrollback buffer. 
This option is only for users of full screen VMS environments such as DEC All-In-One.

Berkeley 4.3 CR Mode
This is a special compatibility option for 4.3 BSD UNIX. There is an official UNIX bug fix for this
problem, but some hosts may still want CR-NULL to be used as the end-of-line character.

Allow linemode
When Allow linemode is checked, NCSA Telnet will negotiate and use linemode with hosts that 
support it. If this option is not checked, NCSA Telnet will refuse to use linemode.

TEK Page clears screen
When this option is on, NCSA Telnet’s Tektronix emulation will clear the current Tektronix 
window when a Tektronix clear screen command is received. If this option is off, NCSA Telnet 
will create a new window for the new Tektronix image. Each new screen created in this way has as
its name the session name and time. For more information regarding Tektronix drawing mode and 
the clear screen code, refer to Chapter 5, "Tektronix 4014 and 4105 Emulation."

Half Duplex
This option only applies to hosts that negotiate non-echoing mode but do not expect local line 
editing. If checked, all character keys are sent and echoed to the screen immediately, otherwise the 
characters are echoed locally and queued until a RETURN or CONTROL character is sent. This 
parameter has no effect when local echo is off.

Show low level errors
Turning this option on tells NCSA Telnet to display minor error conditions it normally would not. 
This can be useful when the user is trying to diagnose a problem with NCSA Telnet.

Interrupt, Suspend, and Resume
NCSA Telnet uses certain key combinations for the telnet functions Interrupt, Suspend, and 
Resume. The default key assignments for the Interrupt, Suspend, and Resume functions 
correspond to the traditional interpretation of ASCII characters.

The Interrupt, Suspend, and Resume telnet functions and their default key assignments are 
discussed below.

Interrupt (CONTROL-C) Function

The Interrupt function sends a telnet interrupt process character that is equivalent to the Interrupt 
Process command in the Network menu (see "Network-Related Commands" section in Chapter 3, 
"Advanced Features"). The host implementation of telnet is required to listen for and interrupt the 
current application when this option is received.
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Interrupt also does a timing mark operation. In many implementations of telnet, the user presses 
CONTROL-C and can wait several minutes before the text stops scrolling on the user’s screen. 
This occurs because the TCP protocol has buffered up to 16K or even 32K bytes of data, which is 
waiting in the pipeline to be delivered even before the user presses CONTROL-C. To avoid this, 
NCSA Telnet initiates a process known as timing mark flush when the user issues an interrupt 
command.

To do timing mark processing, NCSA Telnet sends to the host a special character, which the host 
echoes back. While waiting for the host to echo, all characters for that session are thrown away. 
The session appears to pause for up to 15 seconds and then resumes as usual. During the pause 
NCSA Telnet is throwing away all of the buffered data so that the user does not have to wait for it 
to be displayed.

Suspend (CONTROL-S) Function

The Suspend function instantly interrupts all output coming from the network. The current session 
does not produce any more characters on the screen until the user issues the Resume command.

Resume (CONTROL-Q) Function

The Resume function allows character printing to resume to the current session. Resume does 
nothing unless a Suspend command is in effect.

Terminal Popup Menu
The Terminal popup menu selects which terminal configuration record will be used when the alias 
identifying this session configuration record is used to open a session.

Translation Table Popup Menu
The Translation Table popup menu selects which translation table will be initially selected for this 
session.

Terminal Configuration Records

When the user creates a new session record or change an existing record, the following modal 

dialog box is used:

These fields and options are described in the following sections.

Terminal Name
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This is the name of the terminal that will appear among the other terminal configuration records in 
the Terminal popup menu of the session configuration record dialog. When editing the <Default> 
terminal record, this field is hidden.

Xterm sequences
When Xterm sequences is checked, NCSA Telnet will recognize the Xterm escape sequences for 
changing window and icon titles. NCSA Telnet will change the title of the session’s window in 
response to those sequences.

Use VT wrap mode
When this option is on, NCSA Telnet will set the VT emulator to use auto-wrap mode by default.

The VT terminal maintains an internal setting to determine whether characters printed off the right 
hand side of the screen cause the terminal to wrap or not. If the user sets the terminal to wrap, the 
new characters appear on the next line of the screen and the screen is scrolled if necessary. If the 
user disables wrap mode, each new character replaces the last character on the current line and the 
cursor neither moves right nor onto the next line. Whenever the user selects the Reset Terminal 
command in the Session menu, wrap mode is disabled.

EMACS arrow keys
When this option is on, the arrow keys will send the appropriate control codes for moving around 
in the EMACS editor. When this option is off, NCSA Telnet sends the VT codes for the arrow 
keys. This option also affects the codes sent when the option mouseclick feature is used. See the 
section "Cursor Positioning with the Mouse" in Chapter 3, "Advanced Features" for more 
information.

Mapping the PageUp, PageDown, Home, and End Keys
When Map PgUp, etc. is checked, NCSA Telnet will use the PAGE UP, PAGE DOWN, HOME, and
END keys to move the position in the session’s scrollback buffer, rather than sending the VT codes
for these keys to the remote host.

Eight bit connections
When this option is on, NCSA Telnet does not strip the eighth bit from the data it receives.

Save cleared lines
When this option is on, NCSA Telnet saves the screen in the scrollback buffer before clearing the 
screen when a VT clear screen code is received. Otherwise, the data on the screen is lost.

CNTL-COMMAND is EMACS meta
When this option is on, pressing CONTROL, COMMAND, and a key is equivalent to pressing 
Meta and that key on a keyboard that has a Meta key. This option does not allow the sending of 
Meta Control keys since the CONTROL key is needed to activate this sequence. This option will 
be changed in the future to better support simulating Meta key sequences.

Emulation
The VT100 and VT220 radio buttons select VT100 or VT220 emulation for this connection, 
respectively.

Font and Size
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The Font popup menu and the size field to the right of the Font popup menu allow the user to 
specify the font and font size to be used for this connection.

Screen Size
The Screen Height and Screen Width fields allow the user to specify the initial size of the VT 
emulation screen.

Scrollback
The Scrollback field determines the size, in lines, of the scrollback buffer.

Screen Colors
The four fields used for setting the foreground and background colors for normal and blinking 
mode are only visible on color equipped Macintosh computers. When they are present, clicking on 
any of the boxes will present the standard Color Wheel modal dialog box. The boxes are filled 
with the current color selection. For additional information on using the Color Wheel modal dialog
box, refer to the Macintosh System Software User's Guide.

Changing Configuration After the Session Has Been Created

After a session has connected, many of the configuration parameters can be changed by using the 

Session menu.

Each of the items is described in the following sections.

Backspace and Delete
When Backspace is checked, the DELETE key sends a backspace character when pressed. If 
Delete is checked, the DELETE key sends a delete character when pressed.

Local Echo
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When linemode is not being used, NCSA Telnet can operate in two different echo modes: local and
remote. In local echo mode, characters are copied to the screen immediately as the user types 
them. In remote echo mode, the characters are sent to the host, which sends them back to be 
printed. When Local Echo is checked, NCSA Telnet enters local echo mode.

Wrap Mode
Enables or disables the wrap mode of the VT terminal emulator. Refer to "Use VT Wrap mode" in 
the section "Terminal Configuration Records" for further explanation.

EMACS arrow mapping
When EMACS arrow mapping is checked, the arrow keys send codes appropriate for moving 
around in the EMACS editor. When EMACS arrow mapping is not checked, NCSA Telnet sends 
the VT codes for the arrow keys.

Map PgUp, PgDown, Home, End
When Map PgUp/PgDown/Home/End is checked, NCSA Telnet will use the PAGE UP, PAGE 
DOWN, HOME, and END keys to move the position in the session’s scrollback buffer, rather than 
sending the VT codes for these keys to the remote host.

Translation Submenu

The Translation submenu allows the user to choose which translation table will be used for this 
session. In the case above, no translation is desired.

Clear Screen Saves Lines
This option toggles between saving lines and erasing lines when the VT clear screen code is 
received. If the user checks the option, all lines currently displayed on the screen are scrolled into 
the scrollback region before the screen is cleared. If this option is not checked, the cleared lines are
permanently disposed of when the screen is cleared.

Reset Terminal
Select Reset Terminal to reset the VT screen, for example when a host program accidentally sets 
VT graphics mode or fails to leave VT graphics mode. The Reset Terminal command resets all VT 
mode settings, disabling wrap mode, resetting VT graphics mode, resetting the keypad mode to the
default, and resetting tabs to every eight spaces.

Jump Scroll
Select Jump Scroll to skip to the end of the local buffer.

The Jump Scroll option causes the screen to pause and then jump ahead over scrolling text. The 
text is placed into the scrollback, but the screen update advances to the end of the local network 
buffer instead of printing every line on the screen.

The purpose of this feature is to save time. For example, when the user enters a command that 
produces a great deal of output, the user can use Jump Scroll to avoid waiting for the output to 
scroll by.

TEK Page
Select TEK Page to quickly create or clear a Tektronix emulation window without requiring 
intervention from host software.
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Normally the emulation window appears automatically when the clear screen command sequence 
is received from the host. But the TEK Page command creates the window immediately. To clear 
the current session window, use the TEK Page command the same way the user would use the Page
key on a real Tektronix terminal. For more information regarding the clear screen command and 
Tektronix emulation, refer to Chapter 3, "Advanced Features."

The TEK Page option is disabled if the user has selected Inhibit as the TEK Emulation in the 
session configuration record used to create this session. Refer to "TEK Options" in the section 
"Session Configuration Records" for more information.

TEK form feed clears screen
Setting this option forces NCSA Telnet’s TEK emulation not to clear the screen when a form feed 
is encountered. Often TEK images include a form-feed command at the end of them which cause 
the TEK screen to be immediately cleared upon reaching the end of the image. However, this 
makes it hard to see the final image of the TEK file. 

Set Screen Size
Select this option to change the size of the VT emulation screen.

NCSA Telnet’s VT emulation screens contain 24 lines by default, because an actual VT terminal 
screen has room for exactly 24 lines of text. Some host systems allows the user to define a VT-like 
terminal type which has more or fewer than 24 lines. NOTE: The user may change this default by 
changing the terminal configuration record. Refer to "Screen Size" in the section "Terminal 
Configuration Records" for more information.

To increase or decrease the size of the VT emulation screen:

Select Set Screen Size from the Session menu. A modal dialog box appears, showing the 
current number of lines and columns in the VT emulation screen.

Change the value as desired.

Click OK or press RETURN to return to the user’s session window or click Cancel to abort the
change.

If the user changes the size of the VT emulation screen, the session window will resize to reveal 
the entire VT screen.

Shortcut

To quickly change the size of the VT emulation screen, hold down OPTION before adjusting the 
size of the window using the size box. As the window changes size, NCSA Telnet recalculates the 
number of lines in the window and displays the current dimensions in the upper left corner of the 
window. When the user releases the mouse button, the size of the VT emulation screen will be set. 
This method is equivalent to using the Set Screen Size command. NOTE: Resizing a session 
window without holding down OPTION only resizes the Macintosh window and does not change 
the size of the VT emulation screen.

WARNING: If the user does not have a good working knowledge of how the user’s host system 
makes us of terminals with greater than 24 lines, you are recommended to use only 24-line 
windows. The following warnings and suggestions assume knowledge of 
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UNIX-based software to control the number of lines for the terminal. Consult your host system 
documentation or system administrator for more information.

Warnings and Suggestions

The termcap file, (found in UNIX systems only), is commonly located in /etc/termcap, and can be 
set up to include the number of lines on the terminal. The default VT100 termcap includes an 
explicit setting of 24 lines, so even if you enlarge your NCSA Telnet window, the host uses only 
the top 24 lines. You can create special termcap entries by editing the /etc/termcap file. Copy the 
VT100 entry to a new name and change the number of lines to your preferred screen size.

Berkeley UNIX-based systems have a special feature in the stty program. The number of rows in a 
session window can be set to any value, and applications programs such as vi learn your window 
size from the stty setting. The following command line sets the window size to 33 lines.

stty rows 33

Using the special macro variable #, you can create a macro that issues this command and 
automatically substitutes the number of lines for the current window. For example, you could 
define the macro for -0 as the following.

stty rows \#

Now, you can set the window size by pressing -0 and then RETURN. The sequence \# is 
replaced with the proper number of lines.

See the section "Defining Macros" in this chapter for information about creating and saving 
macros.

Some systems have a program installed called resize. Resize sends a special sequence of VT 
control characters to NCSA Telnet’s VT emulator to determine the size of the screen. If resize is 
available on your system, putting

resize > /dev/null

in your .cshrc or .login will automatically set your screen size correctly when you log in. For help 
using resize and determining if it is available at your site, contact your system administrator.

NAWS

NAWS, Negotiations About Window Size, is a relatively new option in the telnet standard. UNIX 
hosts that support NAWS allow NCSA Telnet to send information to the host regarding the VT 
window size. Consequently, when the user changes the VT screen size by using the Set Screen Size 
option, the new screen size is sent over the network to the host. In this case, the user does not need 
to perform the stty rows operation. The host knows how big the window is, which eliminates 
possible problems for screen-oriented applications such as vi. NOTE: NAWS is not supported by 
all UNIX machines. You can determine if the host you are connected to supports NAWS by 
changing the size of the VT emulation screen and then asking the remote host for the screen size. 
If the screen size the host responds with matches the new screen size you have just set, the host 
supports NAWS.

Setup Keys
Select Setup Keys to select which keys, if any, issue the telnet commands Interrupt, Suspend, and 
Resume (see "Interrupt, Suspend, and Resume" in the section "Session Configuration Records" in 
this chapter.)

Font Submenu
The Font submenu contains the fonts that you may use to display text in a session window. When 
you select a font from this submenu, the current window is resized to contain the text and the 
selected font is used to display all text in the current window.
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NOTE: Fonts which are proportionally spaced (most fonts except Courier and Monaco) display 
slowly and appear spread out.

Size Submenu
This option allows you to change the size of text in the current window. The Size submenu contains
the point sizes that you may use to display text in a session window. The submenu lists several 
sizes, displays a check-mark next to the current size, and outlines all sizes present in your system. 
When you select a size from this submenu, the current window is resized to contain all the resized 
text and the text is redrawn according to the specified point size.

NOTE: Sizes which do not appear outlined in the submenu must be scaled by the system software 
and therefore may be slow and not as sharply defined as the non-scaled sizes.

Color
The Color option only applies to Macintosh computers that are color-equipped. Select Color to 
change the foreground and background colors of the current window for both normal text and 
blinking text. The Color Selection modal dialog box appears.

To assign a color to text or the background of a session window:

Click the box next to the item to which you wish to assign a color: Normal Text, Normal 
Background, Blinking Text, or Blinking Background. This will bring up the Color Wheel modal 
dialog box.

Select a new color by clicking in the color wheel. The color you select appears in the top rectangle 
under the heading Please Select New Color.

Click OK or press RETURN to enable the color change and return to the Color Selection 
modal dialog box. The box next to the item you selected in Step 1 reflects the color you chose 
from the Color Wheel modal dialog box.

Repeat Steps 1 through 4 to assign colors to other items in the Color Selection dialog box.

Click OK when you have finished choosing colors. The colors you selected are applied to your
current session window.

For additional information on using the color wheel dialog box, refer to your Macintosh System 
Software User's Guide.

Capture Session to file
NCSA Telnet is able to save the text from a session to a file. When Capture Session to file is 
selected, all normal text output that appears on the screen will also be saved to the file specified by
the user in the standard save file dialog presented. This functionality turns on when the user selects
this menu item, and turns off when the user again selects the menu item. As is standard with NCSA
Telnet, a check will appear in the menu when this option is selected, to inform the user that the text
from that session is being captured.
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Saved Sets

NCSA Telnet makes it easy for you to begin multiple telnet sessions quickly. This allows you to 
log on and get right to work without resetting the special characteristics and configuration of a 
connection each time you start up. This is accomplished through saved sets.

A set is a snapshot of the open sessions and their current configuration. A set consists of current 
macro settings and each session's window location and size, connected host, window name, 
scrollback setting, color, font, font size, backspace/delete settings, and all other configuration 
information.

Saving a Set
To save a set:

Log on to the desired host as instructed in Chapter 1, "Getting Started."

Customize the session by moving the session window to an ideal location on the screen, specifying
a background or text color, choosing a font and font size, setting the desired number of 
scrollback lines, and choosing the function for the BACKSPACE/DELETE key.

Select Save Set from the File menu. 

A standard file dialog box appears and prompts you to name the set. After naming the set, click on 
the Save button in the dialog box to save the set.

Using a Saved Set
Using sets lets you bypass the start-up procedure described in Chapter 1, "Getting Started." 
Specifically, you do not need to select Open Connection from the File menu or press - -O to open 
a connection, nor do you need to specify the connection host or window name. These operations 
are performed automatically when you load a set.

After you load a set, the session window automatically appears for the specified host at the 
specified location on the screen and with the specified window name, scrollback setting, color and 
other characteristics. The following characteristics are saved in a set:

session name
hostname
port number
window size and location
scrollback setting
BACKSPACE/DELETE key setting
macro definitions
command key setting
number of columns
Tek clear screen setting
font and font size
color characteristics
assigned keys for Interrupt, Suspend, and Resume functions
CRMAP setting
"Allow linemode" setting
eightbit status
translation table setting
TEK emulation setting
answerback message

Loading a set from the Finder
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To load a set from the Finder and automatically invoke NCSA Telnet, doubleclick on the set icon 

or file. The sample below shows the set icon for a set named Setup One. 

Loading a set from within NCSA Telnet

To load a set from within the NCSA Telnet application, select Load Set from the File menu. In the 
standard file dialog box that appears, select and open the set.

NOTE: You can edit a set datafile using any editor capable of editing files, even if the files are not
of the operating system type TEXT. However, NCSA recommends that you do not rely on this 
feature, as it may not work with future versions of NCSA Telnet.

Defining Macros

NCSA Telnet lets you use the key combinations -0 through -9 as macro keys. You can  
program these keys to send from 0 to 255 characters.

To define a macro:

Select Set Macros from the Edit menu or press -M. The Macro Configuration modal dialog box 
below shows several sample macro definitions.

Click on the button of the command key you wish to define, or select the box next to that button.

Enter the appropriate macro key sequence as instructed in the following section.

Click on the OK button in the dialog box (or press the RETURN key) to activate the new macros, 
or click on the Cancel button to invalidate the additions or changes you made. Clicking either 
the OK or Cancel button returns to the application.

Reverting to the Previous Macro Definitions
While you are working in the Macro Configuration dialog box, you can undo changes you made to
a macro and revert the associated command key to its previous setting by clicking on the button 
corresponding to that command key. For example, to undo changes to the definition for -2, click 
on the button labeled 2 . To simultaneously abandon all changes you have made, click on the 
Cancel button.

Entering Macro Key Sequences
The key sequences used to generate special control characters in a macro may seem somewhat 
strange, unless you are familiar with the C programming language. To define a special character, 
you must first enter a backslash (\). Indicate nontypable control 
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characters with their equivalents in the octal numbering system. Below are some common macro 
key combinations you might want to enter:

Desired Character                    Definition
Backslash (\)                        \\
TAB                                  \t
ESC       \033
CONTROL-C       \003
CONTROL-D       \004
CONTROL-E       \005
CONTROL-H or BACKSPACE               \010
Size of current window†       \#
Internet address of this Macintosh†† \i

†   Concerns setting the number of usable lines in a session window. See the 
   "Using the Session Menu" section of this chapter.
††  See also the discussions of the Show Network Numbers command in the "Network-
   Related Commands" section of Chapter 3, "Advanced Features," and of the 
   Send IP Number command in the "Transferring Files" section of Chapter 4, 
   "File Transfer."

Saving Macros
Currently, the only way to save the macro settings is in a set file. See the section "Saved Sets" in 
this chapter for more information regarding sets. NCSA plans to extend the macro capability of 
NCSA Telnet in future versions.
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Advanced Features

This chapter covers more advanced aspects of the working environment of NCSA Telnet for the 
Macintosh®. It describes how to open multiple sessions, change window titles, position the session
cursor using the mouse, use authentication and encryption, and use telnet options and network-
related commands.

Opening Multiple Connections

NCSA Telnet allows you to have multiple connections, either to a single host or to several different
hosts. To open another connection, just repeat the procedure for opening a connection (presented in
Chapter-1, "Getting Started") or load a set as instructed in the section "Saved Sets" in Chapter 2, 
"Configuration".

The connection with which you are currently working is the active session. Generally, its session 
window appears frontmost on your desktop.

To switch between active sessions and place the active session window in front, either click on the 
session window for the desired connection or select the associated session name from the 

Connections menu.

To activate the next session, select Next Session from the Connections menu. If you are using 
command-key mode, press -N (for next) to activate the session window directly beneath the 
current session window.

When opening multiple sessions, NCSA Telnet opens new windows on the screen relative to the 
number of windows currently opened. You can specify that these windows be staggered by just a 
few pixels or by the whole window title bar. For more information see the "Staggered Windows" 
subsection of the section "Global Preferences" in Chapter 2, "Configuration."

Rules for Session Names

When you have multiple connections to a single host, it is useful to specify session names (other 
than the hostname) for the connections. NCSA Telnet allows you to use any of the following for 
session names:

the host’s full Internet address, such as 192.17.22.20.
any session configuration record alias (See the section "Session Configuration Records" in 

Chapter 2, "Configuration" for more information.)
any name, such as sri-nic.arpa, that can be resolved by the domain-based nameserver.

NOTE: Some systems, such as MFENET, do not use the standard telnet port number 23. If you 
need access via the telnet protocol to a different port number, in the Open Connection dialog box 
enter the port number after the session name; the session name and port number must be separated 
by one or more spaces. For example, to open a connection to port 23 of myhost.network.arpa, enter
myhost.network.arpa in the text box labeled Host/Session Name. Similarly, to open a connection to 
port number 911 of the same host, enter myhost.network.arpa 911. Alternate port numbers may also 
be specified in session configuration records.

The Connections Menu
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You can specify titles other than session names for your session windows. Doing so allows you to 
easily distinguish between multiple sessions and session windows.

To specify a window title, enter the name in the Window Name box in the Open Connection dialog 
box.

NOTE: If you leave the window name blank when you open a connection, NCSA Telnet 
automatically numbers the session. Each time you open a session, the number increases regardless 
of how many sessions are currently open.

The Connections menu contains the window names for current connections as well as the status of 
each session. A checkmark (_) next to a window name indicates an active session, and a diamond 
(♦) or circle (•) next to a session name indicates an attempted connection that has not yet been 
successfully opened. More specifically, a diamond indicates that NCSA Telnet is checking the 
nameserver to find the session name or hostname; a circle means NCSA Telnet is trying to open 
the session. Once the connection is established, the diamond or circle next to the session name 
goes away and the session window appears.

NOTE: If you do not remember the meaning of the symbols used in the Connections menu, just 
select the connection in question from the Connections menu. The Connection Status dialog box 
appears to report the name and status of the connection. After reading the message, click on the 
OK button in the dialog box (or press RETURN on the keyboard) to proceed with opening the 
connection. To cancel the attempt, click on the Abort button.

Aborting Connection Attempts

To abort a connection attempt:

Select the desired connection from the Connections menu. The Connection Status dialog box 
appears, reporting the name and status of the connection.

Click on the Abort button in the Connection Status dialog box.

Changing a Window Title

By selecting Change Window Title… from the Connections menu, you may change the window title 
of the frontmost window.

Telnet Options
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The five telnet options provided by NCSA Telnet are included in the Network menu:

Send FTP Command
When you select this item, NCSA Telnet sends ftp w.x.y.z (where w.x.y.z is the IP address of your 
Macintosh) followed by a return character to the remote machine. If the FTP server is in 
anonymous mode, NCSA Telnet sends ftp -n w.x.y.z followed by a return character to the remote 
machine, unless the shift key is down. Holding the shift key down forces NCSA Telnet not to use 
the -n option. See Chapter 4, "File Transfer," for more information about FTP commands.

Send IP Number
After selecting this item, NCSA Telnet sends the IP address of the Macintosh you are using to the 
remote machine as if you had typed it in manually.

Send "Are You There?"
Every once in a while, perhaps because the host is bombarded with incoming information or tied 
up by a large number of users, it seems as if the host is not responding to your commands. When 
this happens and your terminal appears to have locked up, you can verify that you are still 
connected to the host by selecting Send "Are You There?" from the Network menu or by pressing --

-/.

The host is supposed to respond, if able, with a readable message. Some machines answer [Yes]; 
others answer with more informative messages. Use this command whenever you are unsure 
whether the network and host are up.

Send "Abort Output"
The Send "Abort Output" command is supposed to throw away all output from the currently 
running process and then resume when there is a pause. Very few hosts implement this command 
correctly.

Send "Interrupt Process"
The Internet standard telnet protocol defines several special commands that NCSA Telnet supports.
Each host telnet implementation treats these commands differently, so they may have no effect on 
some hosts.

Available on nearly every telnet host, the Send "Interrupt Process" command stops the current 
process and throws away all pending data for the connection. The Interrupt Process command is 
equivalent to pressing CONTROL-C on most UNIX systems. NCSA Telnet can also map 
CONTROL-C to the Send "Interrupt Process" command. You can change this key combination 
using the Setup Keys command in the Session menu, as described in the "Changing Configuration 
After the Session Has Been Created" section of Chapter 2, "Configuration."

Send "Erase Character" and "Erase Line"
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When you enter commands you can erase the last character or the current line by issuing the Send 
"Erase Character" and Send "Erase Line" commands, respectively. Many hosts do not implement 
these commands, but use their own special characters instead.

Network-Related Commands

Two of NCSA Telnet's network-related commands (Suspend Network, and Show Network Numbers)
appear in the Network menu.

Suspend Network Command
To temporarily suspend all network communications, select Suspend Network from the Network 
menu. This command disables all receive functions. All of your connections are kept alive, but you
do not see any incoming text.

NOTE: Generally you should use the Suspend and Resume commands discussed in the "Interrupt, 
Suspend, and Resume" subsection of the section "Session Configuration Records" in Chapter-2, 
"Configuration," rather than the Suspend Network command.

Show Network Numbers Command
Since NCSA Telnet now uses MacTCP for all network communications, this item is largely 
unnecessary. However, for purposes of continuity, this item will display a dialog box with your 
Macintosh’s IP address if selected. This command does not transmit your IP address. Click on the 
dialog box to remove it.

Cursor Positioning with the Mouse

You can use the mouse to position the session cursor when using a full screen editor that supports 
the arrow keys, such as vi. Holding OPTION down while the mouse cursor is over a session 
window will change the mouse cursor into a rectangle. Pressing the mouse button while the mouse 
cursor is in the session window and the OPTION key is held down will tell NCSA Telnet to send a 
sequence of arrow keys to move to that position on the screen. NOTE: If you are using EMACS 
rather than vi, you should set the option EMACS arrow keys in the session configuration record, or 
check the EMACS arrow mapping item in the Session menu.

Authentication and Encryption

To use Authentication or Encryption, you’ll need to get the Kerberos Client extension and KConfig
application from NCSA’s FTP server. Please refer to Appendix C, "Obtaining NCSA Software" for 
more information regarding retrieving files from NCSA’s FTP server.

NCSA Telnet uses Cornell's Kdriver package for Kerberos and encryption support routines. 
KConfig, an application written by Rick Watson, is used to configure settings for Kdriver.

If you use a version of the Cornell Kerberos driver obtained from a source besides NCSA, 
encryption will not be supported, some settings changes made by KConfig won't be saved in the 
preferences file, and the ticket display may show garbage for the user realm.

Kdriver supports Kerberos V4. Kdriver requires that each Kerberos server host also be running a 
UDP daytime server.

NCSA Telnet supports the Telnet Authentication and Encryption options described in 
RFC1411/1416 and IETF drafts dated July 1991. Future versions may support the IETF draft 
AUTH_ENCRYPT option described in the draft dated April 1993.

Installation
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Kdriver must be installed in your System Folder to work. Drag the Kerberos Client extension to 
your closed System Folder. On System 7 machines, you will be asked to verify that the file will be 
placed into your Extensions folder.

Reboot your Macintosh and use KConfig to configure settings for your Kerberos environment.

Using KConfig
This section assumes you are familiar with Kerberos.

Domain/Hostname to Realm maps are useful if you are supporting more than one Kerberos realm. 
The map will attempt to match up a Kerberos realm with IP domain names.

Enter Kerberos server IP addresses or hostnames for each Kerberos realm that you are using. After 
you have entered your Kerberos servers, you can pick your local realm using the Local Realm 
popup menu at the top of the configuration dialog.

The Login button will allow you to authenticate to a Kerberos server and obtain an initial ticket 
granting ticket for other services. You don't have to login using KConfig, NCSA Telnet will prompt
you when a password is needed.

The Logout button destroys all tickets.

Use the Show Credentials menu item in the File menu to display all your Kerberos tickets.

The Change Password button allows you to change your Kerberos password.

You may (or may not) have to reboot after making initial settings. 

Activating Authentication and Encryption in NCSA Telnet
Options to Authenticate and/or Encrypt a session occur in two places in NCSA Telnet.
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Select the appropriate options for each session that you configure, including the Default session. 
Options for the default session will be presented in the Open Connection dialog box. 

You may select the Authenticate and Encrypt options when opening a session. The Authenticate 
option is required for Encryption. Ftp sessions cannot currently be authenticated or encrypted.

Encryption Active Indicators.
Padlock indicators serve as a visual indicator that a session is encrypted. For NCSA Telnet, this is 
displayed next to the zoom box in the window's titlebar.

If anything other than the padlock is displayed, the session is not two-way encrypted. An arrow 
indicates that the session is encrypted in one direction only. This is probably evidence of a bug in 
the NCSA Telnet code or your telnet server. The absence of any indicator means that no encryption
is taking place.
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File Transfer

This chapter discusses the various features NCSA Telnet for the Macintosh® provides for 
transferring Macintosh-specific and other files. It also describes the most common File Transfer 
Protocol (FTP) commands.

Terminology

The following terms are frequently used in this chapter's discussions concerning file transfer 
procedures.

ASCII File 
An ASCII, or text, file is one that you can read. You can use it with standard editors on the 
Macintosh or host. When text files are transferred, they are translated to a format appropriate for 
the receiving machine.

Binary File
A binary, or image, file cannot be read by standard text editors. Unlike ASCII text files, binary 
files are not changed in any way when transferred.

Client/Server
The client is the computer system that requests services, and the server is the system that provides 
services. The client is not always your Macintosh, despite appearances. When you use NCSA 
Telnet for the Mac to connect to a host, your Macintosh is the telnet client. When you request a file
transfer from your Macintosh, the transfer is actually initiated on the host, making the host the FTP
client and your Macintosh the FTP server. So your Macintosh can be both a telnet client and an 
FTP server at the same time.

File Transfer
In a file transfer, the contents of a file are copied to a file on another computer.

MacBinary File
A MacBinary file is a file that has been encoded in the MacBinary file format. This means that the 
file contains all of the information contained in a normal Macintosh file and therefore can be used 
for transferring applications and other Macintosh-specific files. MacBinary files are virtually 
useless on any other machine, but are in a format that allows them to be stored for downloading 
later to a Macintosh.

About File Transfer Protocol (FTP)

NCSA Telnet for the Mac has an internal FTP server that permits reliable file transfers between a 
Macintosh and any FTP host on the network. File transfers are initiated from the FTP host. With 
the NCSA Telnet implementation of FTP, you can:

Stream transferring files in either text (ASCII) or binary (image) format. 
Change the directory.
Show the name of the current directory.
List files in the current directory (with wildcard specifications).
Send and receive multiple files with one command (using wildcards).

NOTE: File transfers are processed in the background. Therefore, while a file transfer is in 
progress you can perform other NCSA Telnet activities such as switching sessions, adding new 
sessions, or changing parameters. While one FTP connection is active, requests for another are 
ignored.
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Configuring the FTP Server

To configure the FTP server, select FTP Server from the Preferences submenu of the Edit menu. A 
modal dialog box will appear:

Each of these options are described in the following sections.

Server Mode
NCSA Telnet’s FTP server can operate in three modes. When Off is selected, NCSA Telnet will 
refuse all FTP connections to your Macintosh. When On, No passwords needed is selected, NCSA 
Telnet will allow anyone to connect to your Macintosh through FTP. When On, Username & 
Password required is selected, NCSA Telnet requires connecting users to supply a valid username 
and password before gaining access to your Macintosh through FTP. (For information regarding 
the configuration of usernames and passwords for FTP, see the section "Controlling Access" in this
chapter.)

WARNING: NCSA recommends that you do NOT leave the FTP server in the On, No passwords 
needed mode. This mode allows ANYONE access to your entire filesystem. This mode is included 
in NCSA Telnet for quick and simple file transfers. It is not included to be used as a part of a 
permanent configuration setup.

Show FTP log at start-up
When this option is checked, NCSA Telnet will display the FTP log when NCSA Telnet is 
launched.

Use Macbinary II
When this option is selected, NCSA Telnet will use Macbinary transfer mode when in binary 
mode. This can be turned off or on from this dialog, or by sending quote macb enable or quote macb 
disable to the FTP server.

Reset Macbinary after each transfer
NCSA Telnet can save you the trouble of tracking whether Macbinary transfer mode is enabled 
each time you want to transfer files. When Reset Macbinary for each transfer is enabled, the status 
of MacBinary transfer mode returns to the default of your preference, enabled or disabled, 
whenever you begin a new FTP session. This ensures that MacBinary mode is set to your preferred
default each time you open a new FTP session, regardless of how you set the mode in a previous 
FTP session.

NOTE: Each FTP corresponds not to the individual file transfer but to the opening of each FTP 
command connection.
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Binary Filetype and Creator

Using the Binary Filetype and Creator fields, you can specify the filetype and file creator type for 
files transferred in binary mode when Macbinary transfer mode is disabled. Selecting the Example 
button allows you to select a file using the standard file dialog box and determine the filetype and 
file creator type for that file. For more information regarding filetypes and file creator types, refer 
to the subsection "Creator File Type" in the section "Global Preferences" in Chapter 2, 
"Configuration."

Text Creator
Using the Text Creator field and Select Application button you can select the four letter file creator 
type given to files transferred to your Macintosh using the ASCII transfer mode. For more 
information regarding filetypes and file creator types, refer to the subsection "Creator File Type" in
the section "Global Preferences" in Chapter 2, "Configuration."

Controlling Access

To configure who has access to your Macintosh via FTP, select FTP Users from the Preferences 
submenu of the Edit menu. A modal dialog box similar to the following will appear:

Using this dialog box, you may add new users, change an existing user’s information, or remove a 
user’s access privileges. In this case, there are three users: jbrowne, melliott, and uldhmi.

Selecting New or Change will bring up the following modal dialog box:

The Username field specifies the name that will be recognized by NCSA Telnet’s FTP server at the 
username prompt.
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You may type in the user’s password in the Password field. When entering new passwords, they are
displayed in normal text. When changing records, the password field always displays eight bullets 
(•) regardless of the length of the actual password. Passwords are kept in the preferences file in an 
encrypted format. NOTE: The encryption method used on the passwords is quite simple. It will 
prevent the casual user from discovering your passwords, but you should never give anyone a copy
of your preferences file.

NCSA Telnet’s FTP server places each user in a default directory when that user logs in using the 
correct username and password. The Default Directory field displays the default directory for this 
user. The Change Default Directory button allows you to change the default directory for the user.

In this case, the user is "jbrowne". His password is not displayed, and his current directory after 
logging in via FTP will be "/slot6drive1/."

Transferring Files

Before you attempt to transfer files using FTP, make sure the following conditions are met:

Your host system supports FTP file transfer. If you do not know whether it does, see your system 
administrator.

You have not disabled the file transfer capability of NCSA Telnet for the Mac. Two conditions 
inform you that the FTP capability is disabled: (1) the Server Mode is set to Off in the FTP 
Server Preferences modal dialog box and (2) your machine does not respond to the FTP 
command when you attempt to start up FTP. See the section "Configuring the FTP Server" in 
this chapter for more information.

Invoking FTP on the Host Computer
Since FTP is initiated by the remote host, the FTP commands vary depending on the host system. 
For full documentation of FTP and commands within FTP, refer to the manuals for the host 
computer. On UNIX systems you can read online documentation by entering:

% man ftp

Issuing the FTP Command
On most systems, at the prompt you enter the FTP command and the IP name or IP address of the 
target machine. You can enter the FTP command in one of three ways. For example, if your 
Macintosh is named mymachine and your IP address is 192.17.20.22, any of the following 
procedures invokes FTP.

Enter either the machine name or IP address and then press RETURN:

% ftp  mymachine     or     % ftp 192.17.20.22

Select Send FTP Command from the Network menu or press -F . Either one causes NCSA Telnet 
to enter the FTP command and issue a RETURN.

Enter ftp-SPACEBAR, select Send IP Number from the Network menu, and press RETURN. The 
Send IP Number command enters your IP address for you.

Use whichever method you are comfortable with to invoke FTP. Your host computer may not 
accept FTP commands as described here, so you may have to try some variations to find the easiest
method for your site.

Regardless of how you invoke FTP, most FTP clients generate a response like this:

Connected to 192.17.20.22.
220 Macintosh Resident FTP server, ready
Name (192.17.20.22:uldhmi):

Most FTP clients prompt for your username and password. If NCSA Telnet for the Mac is 
configured for passwords (see "Configuring the FTP Server" in this chapter), then you must enter a
password. Otherwise, just press RETURN to bypass the prompts. If you are 

Running H/F 2 ➢ 34



35 ➢ NCSA Telnet for the Macintosh®
not prompted for a username and password, assume that you are logged on and enter your FTP 
commands at the FTP prompt.

NOTE: When an FTP connection is active, the cursor changes to a small file icon: 

When the FTP connection terminates, the small file icon changes back to the standard I-beam 
cursor.

FTP Commands
After FTP is invoked and passwords are checked, most FTP clients prompt you for individual FTP 
commands. These commands are documented in the manuals for the host computer. Most FTP 
implementations have similar commands because they are modeled after the Berkeley UNIX 
version of FTP.

Once you are in FTP, you can access online help for a list of available commands. FTP commands 
that are common to most implementations are listed below (boldface type indicates user entries 
and italics type indicates variables) and are described in the following subsections:

Command Action

ascii Sets mode to ASCII transfer mode (default)

binary Sets mode to binary (image or I) transfer mode

cd Changes the directory on your Macintosh

dir Shows filenames in the Macintosh's default directory

get filename Gets specified file from the Macintosh and sends it to the host

help Shows an online list of FTP commands

put filename Sends specified file from the host to the Macintosh

pwd Shows the name of the current Macintosh directory

FTP Log
To help you keep track of file transactions, NCSA Telnet shows current and past transactions in the

FTP log, like the sample below:

To view the log, select Show FTP Log from the File menu.

Setting the Transfer Mode
The default mode for FTP transfers is ASCII format. To transfer graphic or binary data files, you 
must change the transfer mode to binary format before using the put or get commands. To set the 
transfer mode to binary, enter either binary or bin.

If you intend to use the file you are transferring with a Macintosh-specific application, you may 
also need to set MacBinary transfer mode. For more information, see the "Transferring MacBinary 
Files" subsection later in this section.

To set or reset the transfer mode to ASCII format, enter ascii.

Examples in the "Transferring Files to the Macintosh" section later in this chapter demonstrate 
FTP transactions with an ASCII file and with a binary file.
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Changing the Current Directory

FTP transfers files to the default directory on your local disk. To change the directory, enter cd at 
the FTP prompt (ftp>).

The cd command from FTP (shown in the list of common FTP commands) requires you to specify 
a directory by manually entering a path instead of using a dialog box. To specify a directory using 
the cd command, use the colon (:) or slash (/) to separate folder names (as the Macintosh requires).

For example, to change the default directory to a directory named myfolder on your local 
Macintosh disk named hd20, enter one of the following at the FTP prompt: 

ftp> cd ":hd20:myfolder"     or     ftp> cd "/hd20/myfolder"

To find out which directory is set as your default transfer directory, enter pwd at the FTP prompt. 
For example, entering the pwd command after the sample cd command above results in the 
following:

ftp> pwd

"/hd20/myfolder" is the current directory

Transferring Files to the Macintosh
Even though you seem to be initiating the transfer from the Macintosh, the transaction actually 
operates from the host's side. The practical effect of this arrangement makes the commands seem 
backwards. For example, to transfer a file from the host to your Macintosh, do not use a get 
command as you might expect, but a put command in the form:

put filename.ext

The following example demonstrates how to use the put command to transfer the ASCII file temp2
from a host to a local Macintosh. Boldface type represents user entries:

% ftp -n 192.17.20.124
Connected to 192.17.20.124.
220 Macintosh Resident FTP server, ready
ftp> put temp2
200 This space intentionally left blank <  >
150 Opening connection
226 Transfer complete
262145 bytes sent in 32.61 seconds (7.8 Kbytes/s)
ftp> quit
221 Goodbye
%

NOTE: Do not exit the program while a file transfer is in progress or the file transfer will fail.

Transferring Files to the Host
To request that a file be sent from the Macintosh to the host, use a get command in the form:

get filename.ext

The following example demonstrates how to use the get command to transfer the binary file 
bridge.pic from a local Macintosh to a remote host. Note that the file is in the directory 
/HD20/pictures, and the cd command is used to locate that directory. Again, boldface type represents
user entries:

% ftp -n 192.17.20.124
Connected to 192.17.20.124.
220 Macintosh Resident FTP server, ready
ftp> bin
200 Type set to I, binary transfer mode
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ftp> cd "/hd20/pictures"
250 Chdir okay
ftp> get bridge.pic
200 This space intentionally left blank < >
150 Opening connection
226 Transfer complete
262144 bytes received in 9.22 seconds (28 Kbytes/s)
ftp> quit
221 Goodbye
%

To send a text file after this transfer is complete, you must first enter ascii to reset the transfer mode
to ASCII.

Transferring Multiple Files
Some versions of FTP let you transfer multiple files sequentially with one command, either mput 
or mget, and wildcard characters.

WARNING: If you transfer multiple binary files using a UNIX host, note that there is a bug in the
mget command as implemented on some systems (especially 4.2 BSD UNIX systems). When used 
in binary mode, mget adds a carriage return to the filenames as they are transferred. The files 
themselves are not affected. Use a UNIX utility to remove the carriage return from the filename. 
When used in ASCII mode, the mget command causes no problems.

The trick to using wildcards in FTP get commands is to enclose the filename in quotation marks. 
For example, enter get "*.image". Do not use quotation marks with put commands.

Transferring MacBinary Files
Sometimes you may need to upload Macintosh-only files to non-Macintosh hosts, then download 
them later without losing any Macintosh-specific data such as icons and creation date.

To transfer Macintosh-only files (such as applications and most data files) to an intermediate host 
while retaining all Macintosh-specific information in those files:

Enable the MacBinary Enabled item on the File menu. A checkmark appears next to the command 
when it is enabled. You can alternately enable and disable MacBinary by selecting this option. 
(The MacBinary transfer protocol is available only when FTP is in binary mode.) When 
MacBinary is enabled, all get and put commands transfer Macintosh files in MacBinary 
format.

Set the file transfer mode to binary by entering either binary or bin at the FTP prompt.

NOTE: If you are writing host-based scripts to download from or upload to a Macintosh in 
MacBinary mode, enter quote MACB ENABLE and quote MACB DISABLE from the host's FTP 
client to enable and disable MacBinary mode, respectively.

FTP Client

NCSA Telnet can connect directly to the FTP port of a host machine, allowing you to transfer a file
directly between the remote host and Macintosh. To transfer a file from a remote machine to a 
Macintosh, you normally need to:

Log on to any UNIX account.

Transfer the file from the remote host to your UNIX account via FTP.

Transfer the file from your UNIX account to the Macintosh via FTP.

This procedure transfers files directly between a UNIX host and your Macintosh and removes the 
need to log on to a secondary UNIX account for FTP to use as a temporary go-between. 
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Logging on to the FTP Client

To start an FTP client session, click on the FTP Session button in the Open Connection dialog box. 
This opens a window displaying an FTP client connection message that is similar to the one below:

NOTE: Clicking on the FTP Session button is exactly the same as opening a connection to a UNIX
machine on port 21, which is the FTP port. Therefore, if you set up an alias to a machine with port 
21, all sessions opened to that alias are FTP clients. For more information about aliases and session
configuration records, see "Session Configuration Records" in Chapter 2, "Configuration."

To use the FTP client: 

You must first log on to the server.

Enter user followed by your login name and press RETURN. Example:

user loginname RETURN

The host sends a message prompting you to enter your password. 

Enter your password and press RETURN.

If you are logged in, the host sends back a message saying that you are connected properly.

Once logged on, you can use the FTP client just as you would normally use an FTP session.
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Tektronix 4014 and 4105 Emulation

This chapter describes the scope of NCSA Telnet for the Macintosh's® Tektronix 4014 and 4105 
emulation capabilities and explains how to conduct Tektronix graphics emulation sessions and 
operations in graphics windows.

Tektronix Graphics Emulation

NCSA Telnet for the Macintosh can emulate Tektronix 4014 and 4105 terminals. Emulated 
capabilities include text modes, Tektronix 4014 or 4105 text sizing, zoom, and pan. The use of 
Tektronix graphics with NCSA Telnet depends on host programs that can produce graphic images. 
When the host programs run and produce Tektronix 4014 or 4105 graphics commands, NCSA 
Telnet automatically switches into graphics mode, opens a graphics window, and does the drawing.

Getting Started
The type of Tektronix emulation, if any, done for a given session is determined by the TEK field in
the session configuration record. See the section "Session Configuration Records" in Chapter 2, 
"Configuration" for more information.

A host program generates the Tektronix clear screen character sequence (ESC,-FF) over a currently
open connection. When NCSA Telnet receives this command, a graphics window opens. All 
graphics output from the session is redirected into this graphics window until you either close the 
window or send the TEK end command.

Tektronix related options in the Session menu

TEK Page
The TEK Page command in the Session menu provides a quick way to create a Tektronix emulation
window without intervention from host software. Normally the emulation window appears 
automatically as soon as NCSA Telnet receives the clear screen command sequence from the host. 
You can, however, create the window immediately by selecting TEK Page from the Session menu.

Just as you would use the Page key on an actual Tektronix terminal to clear the window for the 
current session, you can select TEK Page to clear a graphics window.

TEK form feed clears screen
When this option is on, NCSA Telnet’s Tektronix emulation will clear the current Tektronix 
window when a Tektronix clear screen command is received. If this option is off, NCSA Telnet 
will create a new window for the new Tektronix image. Each new screen created in this way has as
its name the session name and time.

Graphics Window Operations

NCSA Telnet lets you detach, delete, zoom, copy, resize, and print graphics windows, as described 
in the following sections.

Detaching a Graphics Window
To detach a graphics window, click on the text window for that graphic's connection. Pressing the 
OPTION key while you click on a window lets you click without detaching the corresponding 
graphics window. When a window is detached, its title no longer contains the bullet character (•) 
that identifies it as the active output window.
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The window can also be detached under the control of host software. When the CAN character 
(dec 24) is received, the terminal is reset to VT screen emulation.

Deleting a Graphics Window
To delete a graphics window, click on its close box.

Zooming/Unzooming a Graphics Window
To magnify (zoom in on) a portion of a drawing in a graphics window, drag a selection rectangle 
around the area you want to view more closely. When you release the mouse button, the selected 
section of the drawing expands to fill the entire window. To prevent distortion or stretching of the 
TEK image, the magnified selection always maintains the same aspect ratio as the TEK window.

To unzoom (and see the entire drawing once again), doubleclick anywhere in the window. 

The screen image below shows a Tektronix emulation window at normal size (i.e., at zero 
magnification):

The following screen image shows a portion of the same drawing in zoomed magnification:
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You can copy and print the contents of both zoomed or unzoomed windows. When you copy or 
print a zoomed window, only the visible portion of the window is copied or printed.

Copying a Graphics Window
To copy the contents of a graphics window onto the Macintosh Clipboard, activate the window by 
clicking on it, then choose Copy from the Edit menu. Now you can paste the graphic into another 
Macintosh application.

Resizing a Graphics Window
Although no grow icon is drawn in the Tektronix emulation window, clicking and dragging the 
lower right corner of the window will resize it as if it did have a grow icon.

Printing a Graphics Window
To print the contents of a graphics window on a local printer or a printer on the AppleTalk 
network, activate the window by clicking on it and choose Print Selection from the File menu.

NCSA Telnet centers and scales all graphics to fit the page. To achieve the best possible resolution 
on a LaserWriter, enter 25 percent as the Reduce or Enlarge option in the Page Setup dialog box, as
shown in the sample below. 

25

The 25 percent setting does not change the size of the image but makes the lines thinner.
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For more information about the Page Setup dialog box, refer to your Macintosh user's guide.
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Interactive Color Raster Graphics

This chapter introduces the Interactive Color Raster protocol and describes how to use this 
protocol in your programs to display color graphics with NCSA Telnet for the Macintosh®, how to
control raster graphics windows, and how to display and manipulate color images. The chapter 
concludes with a sample program you can use as a template for designing programs that use the 
ICR protocol.

Interactive Color Raster Graphics

Interactive Color Raster (ICR) is a protocol for displaying raster graphics on your workstation 
screen. The ICR protocol controls its own windows through NCSA Telnet for the Mac and shares 
characteristics of the Tektronix graphics terminal emulation protocol. For example, escape 
sequences control the display.

You can use ICR to write mainframe programs that display color images in their own windows on 
your Macintosh screen, and you can apply the full range of 256 colors out of a palette of 16 
million colors to your graphics displays. The ICR protocol is intended for use on a 256-color 
Macintosh.

Starting and Quitting ICR Graphics Emulation

To use ICR, you need a program that runs on the remote host computer. This program must give all
appropriate commands to conduct ICR graphics emulation. To create an ICR program, work from 
the protocol description contained later in this chapter in the "Using the ICR Protocol" section and 
from the example in the "Sample Program for ICR in C" section. 

When the protocol command for creating a window arrives from the host, NCSA Telnet creates a 
Macintosh window for it. All human-readable text continues to go to the session window, while 
graphics commands are sent to the proper graphics window.

To quit ICR emulation, the ICR program on the remote computer can remove the window. If it 
does not, you can delete a graphics window by clicking in the close box in the upper left corner of 
the window's title bar. If you exit NCSA Telnet while some windows remain open, the windows 
close automatically.

Using the ICR Protocol

You must write a program that issues graphics commands to NCSA Telnet. NCSA Telnet follows 
your programs’ directions to receive graphics commands, interpret them, create or destroy 
windows, set the color environment, or display raster graphics.

Begin all ICR graphics sequence commands with the escape sequence ESC^ (escape, caret) to 
insure that NCSA Telnet can determine the difference between regular text and ICR graphics.

Description of the Protocol
Each ICR command appears in the following form:

ESC^X; parameters ^ data

where:

X is one of the command characters (W, D, M, R, P, or I) described in the table below.
^ is the caret character (ASCII 94).
Parameters is one or more of the parameters of X described in the table below. Parameters are 

always printable ASCII characters and are delimited by commas (,). If your program omits 
parameters, NCSA Telnet supplies default values.
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The command is terminated with a caret (^).
Each command can be followed by a data stream (data). If a command requires a data stream, the

stream follows the command.
Command characters and their parameters are described in the table below: 

Command   Parameters          Description
W         left; top; width;   Creates a window at the specified location on
         height; display;    the screen, where 0, 0 is the upperleft corner
         windowname          of the screen.
                             • The left, top, width, and height integers
                               specify location and size on the screen:

top the pixel value of the vertical, or y, location of the upper-left corner of the graphics window
left the pixel value of the horizontal, or x, location of the upper-left corner of the graphics window

height the number of pixels that comprise the vertical height of the graphics window
width the number of pixels that comprise the horizontal width of the graphics window

Integer Meaning width

left

top

height

•

                     

                             • The display integer identifies the hardware screen
                               number (for machines with multiple screens). This
                               parameter is not applicable to Macintosh systems.
                             • Windowname is a string that distinguishes multiple
                               windows. The windowname assigned to a window is
                               used by all other commands to specify that window.

D         windowname          Destroys a window by physically removing it from
                             the screen and memory.
                             • Windowname is the unique name assigned to a
                               window when it is created by the W command.

M         start; length;      Loads into the graphics window a color map palette
         count; windowname   (of up to 256 colors) or portion of one. NCSA Telnet
                             assumes that palette entries are 8-bit R, G, and B,
                             3 bytes per entry, in that order. The default
                             palette is a straight gray-scale ramp, where 0=black
                             and 255=white.(See "Color Maps" section later in
                             this chapter.)
                             • The start integer identifies the first entry
                               to change.
                             • The length integer indicates the number of
                               entries to change.
                             • The count integer indicates the total number
                               of bytes in the data portion. The count parameter
                               should be followed with the command’s data stream.
                              • Windowname is the unique name assigned to a
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                               window when it is created by the W command.

R         x; y; expand        Indicates that the data to follow are run-length
         length;             encoded. (See the "Run-Length Encoding Format"
         windowname          section later in this chapter.) 
                             • The x and y integers identify the point where
                               the raster line starts and the data follow for
                               length bytes of encoded data.
                             • The expand integer indicates the number of times
                               each dimension is to be expanded on your local
                               screen. For example, an expand value of 2 makes 
                               the picture 4 times larger.
                             • The length integer indicates the encoded length
                               (in bytes) of the data.
                             • Windowname is the unique name assigned to a
                               window when it is created by the W command.

P         x; y; expand;       Indicates that the data to follow are pixel data.   
         length;             • The x and y integers identify the point where
         windowname            the raster line starts and the data follow for
                               length bytes of pixel data.
                             • The expand integer indicates the number of times
                               each dimension is to be expanded on your local
                               screen. For example, an expand value of 2 makes
                               the picture 4 times larger.
                             • The length integer indicates the length (in bytes)
                               of the data. Length should be the same as the
                               number of pixels to be displayed.
                             • Windowname is the unique name assigned to a
                               window when it is created by the W command.

I         x; y; expand;       Indicates that the data to follow are encoded with 
         length;             the IMCOMP compression scheme (4:1 compression).
         windowname          You must use the M command before the picture
                             displayed with the I command appears correctly.
                             • The length integer indicates the number of pixels
                               per line. One I call represents 4 lines of data.
                               Since IMCOMP is a 4 x 4 square compression scheme,
                               each line of data appears as 4 lines of pixels on
                               the screen. 
                             • The y integer is required to increment by fours:
                               0, 4, 8, 12, 16, etc. 
                             • The length integer indicates the length (in bytes)
                               of the data. Length should be the same as the
                               number of pixels to be displayed.
                             • Windowname is the unique name assigned to a
                               window when it is created by the W command.

ASCII Encoding
NCSA Telnet assumes that all parameter values (except ESC) are printable ASCII. This means that
the parameters require no special encoding, but data values need help. ESC is an allowable 
exception on most login data streams.

Your ICR program must encode 8-bit data values into printable ASCII for transmission. When 
possible, the values that fall in the printable ASCII range are passed untouched and all values 
outside that range are encoded as two bytes.

Use the following encoding for all characters 0–255:

Input: realchar

Transmission: specialchar followed by transchar

Running H/F 2 ➢ 45



46 ➢ NCSA Telnet for the Macintosh®
Encoding: specialchar=realchar div 64 + 123 

transchar=realchar mod 64 + 32

Decoding: realchar=(specialchar – 123)*64 + (transchar – 32)

The codes above work to encode data values in printable ASCII character for all characters 0–255, 
as shown below:

Special Range

123 0–63

124 64–127

125 128–191

126 192–255

Because all encoded characters are preceded by a character in the 123–126 range, you can send all 
regular characters that are 32–122 (inclusive) without encoding.

Warning: On CTSS, trailing spaces are trimmed, so you should avoid the values 0, 32, 128, and 
192 because they code to special space.

NOTE: In the specifications, all data lengths and counts refer to the protocol data, not to the 
ASCII-encoded data. The length fields for the R, P, and M commands all reflect the data’s length 
on the originating machine before encoding.

Run-Length Encoding Format
Data for the run-length encoded line are first run-length compressed and then ASCII encoded. 
Therefore the deciphering process first decodes ASCII to binary and then decodes the run-length 
binary data.

Using all 8 bits of the byte stream representing the pixels in a given RLE line, start with the 
control character. (n) represents the lower seven bits of the byte. The high bit represents whether 
the following (n) characters are reproduced exactly (high bit = 0) or whether the following single 
character is reproduced (n) times (high bit = 1).

Input:     1  1  1  1  23  23  23  234  112  33  44  55  42  42  42  42
Tokenized: (128+4)  1  (128+3)  23  (5)  234  112  33  44  55  (128+4)  42
Alternate count, data, count,data

After coding into this tokenized form, you know the data length for the R command. (The length is
12 in the example above). Even though ASCII encoding occurs after this step, use the length value 
from this step.

ASCII result:   125  36  123  33 125  35  123  55  123  37
               126  74  112  33  44  55  125  36  42

Color Maps
You can use the M command to manipulate the color table for your local display. The format for 
color map data is a series of color map entries. Each color map entry is three bytes, one R (red), 
one G (green), and one B (blue). For example, to set entries 3 through 7 of the color table, you 
could use the following M command might be use:

ESC^M;3;4;12;wind^RGBRGBRGBRGB

where the RGBRGBRGBRGB data are the list of byte values for the new entries in RGB order. 
The actual data transmitted over the line must still be ASCII encoded, but the data start out in this 
form. Note that the count field (12 in this example) is always 3 times the length value (4 in this 
example).

ICR Graphics Windows

Raster graphics windows require a lot of memory—one byte for each pixel in each graphics 
window on the screen. If insufficient memory remains to open a new window, NCSA Telnet 
displays an alert dialog box and does not create the window.
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Allocating Memory

If you are using MultiFinder, you can prevent running out of memory by setting NCSA Telnet's 
allocated memory size to a larger value. For example, if you need space for two 256 x 256 image 
windows, increase the memory for NCSA Telnet by 128K (256 bytes x 256 bytes, or 64K, for each
window).

Copying a Graphics Window
You can copy the contents of an ICR window to the Macintosh Clipboard, Then paste it into a 
program capable of pasting color images.

To copy the contents of a graphics window:

Click in the graphics window to bring it to the front.

Choose Copy from the Edit menu. Now you can paste the graphic into another Macintosh 
application.

System Color Problems
Image windows use the colors available for display on your Macintosh screen. When you close 
graphics windows, the system does not always restore the color environment to its original state, 
which causes incorrect colors in other windows. We are working to minimize the effects of NCSA 
Telnet and ICR graphics on your system's color table.

NOTE: Pressing CONTROL-C or using other methods to interrupt ICR commands, can make 
NCSA Telnet appear to lock up. (See also "Telnet Options" in Chapter 3, "Advanced Features.") 
When this occurs, either press RETURN several times or enter commands until the session 
window resumes activity. It may help to remember that when you issue a drawing command 
NCSA Telnet expects an influx of a certain number (often hundreds) of bytes of image data to 
finish drawing the current line.

Sample Program for ICR in C

The sample C program shown below is included on the distribution disk. It produces a test pattern 
on your screen if you are running an active ICR-equipped NCSA Telnet. If you do not have ICR, 
this program produces thousands of encoded characters on your display.

/*   icrtest 
*
*  Produces a test pattern on an ICR compatible display. Demonstrates and provides *  example code for writing ICR programs. 
*
*  National Center for Supercomputing Applications
*  University of Illinois, Urbana-Champaign
*
*  by Tim Krauskopf
*  This program is in the public domain.
*
*/
#include <stdio.h>

int
      xdim=0,ydim=0;                            /* size of image on disk */

char 
      *malloc(),
      *testimage,
      rgb[768];                                 /* storage for a palette */
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main(argc,argv)
      int argc;
      char *argv[];
      {
      register int i,j;
      register char *p;

      puts("Creating test pattern");

      xdim = 150;
      ydim = 100;

      if (NULL == (testimage = malloc(xdim*ydim)))
             exit(1);

/*

*  Make the test image in a strange pattern.
*/
      p = testimage;

      for (i=0; i<ydim; i++)
             for (j=0; j<xdim; j++) {
                    *p++ = 50 + (((i & 0xfffffff8) * (j & 7))>>2);
      }

      puts("Displaying test pattern with the Interactive Color Raster protocol");

      rimage(0);                         /* display remote image with [palette] */

}

/*****************************************************************************/

/*  rimage
*  Remote display of the image using the ICR.
*  Just print the codes to stdout using the protocol.
*/

rimage(usepal)
      int usepal;
      {
      int i,j,newxsize;
      char *space,*thisline,*thischar;
      register unsigned char c;

/*
*  Open the window with the W command.
*/

(void)printf("\033^W;%d;%d;%d;%d;0;test window^",0,0,xdim,ydim);

/*
*  If a palette should be used, send it with the M command.
*/
      if (usepal) {
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             (void)printf("\033^M;0;256;768;test window^");        /* start map */

             thischar = rgb;
             for (j=0; j<768; j++) {
                    c = *thischar++;
                    if (c > 31 && c < 123) {
                           putchar(c);
                    }
                    else {
                           putchar((c>>6)+123);
                           putchar((c & 0x3f) + 32);
                    }
             }
      }

/*

*  Send the data for the image with RLE encoding for efficiency.
*  Encode each line and send it.
*/
      space = malloc(ydim+100);
      thisline = testimage;

   for (i = 0; i < ydim; i++) {
      newxsize = rleit(thisline,space,xdim);
             thisline += xdim;                  /* increment to next line */
                                  
       (void)printf("\033^R;0;%d;%d;%d;test window^",i,1,newxsize); 

       thischar = space;
       for (j = 0; j < newxsize; j++) {

/***********************************************************************/

/*  Encoding of bytes:
*
*  123 precedes #'s 0-63
*  124 precedes #'s 64-127
*  125 precedes #'s 128-191
*  126 precedes #'s 192-255
*  overall:  realchar = (specialchar - 123)*64 + (char-32)
*            specialchar = r div 64 + 123
*            char = r mod 64 + 32
*/

/***********************************************************************/

                    c = *thischar++;            /* get byte to send */

                    if (c > 31 && c < 123) {
                           putchar(c);
                    }
                    else {
                           putchar((c>>6)+123);
                           putchar((c & 0x3f) + 32);
                    }
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             }
      }

      free(space);
}

/********************************************************************/

/*  rleit
*
*  Compress the data to go out with a simple run-length encoded scheme.
*
*/

rleit(buf,bufto,len)
      int len;
      char *buf,*bufto;
      {
      register char *p,*q,*cfoll,*clead;
      char *begp;
      int i;

      p = buf;
      cfoll = bufto;                            /* place to copy to */
      clead = cfoll + 1;

      begp = p;
      while (len > 0) {                         /* encode stuff until gone */

             q = p + 1;
             i = len-1;
             while (*p == *q && i+120 > len && i) {
                    q++;
                    i--;
             }

             if (q > p + 2) {                   /* three in a row */
                    if (p > begp) {
                           *cfoll = p - begp;
                           cfoll = clead;
                    }
                    *cfoll++ = 128 | (q-p);     /* len of seq */
                    *cfoll++ = *p;              /* char of seq */
                    len -= q-p;                 /* subtract len of seq */
                   p = q;
                    clead = cfoll+1;
                    begp = p;
             }
             else {
                    *clead++ = *p++;            /* copy one char */
                    len--;
                    if (p > begp + 120) {
                           *cfoll = p - begp;
                           cfoll = clead++;
                           begp = p;
                    }
             }
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       }
/*
*  fill in last bytecount
*/
      if (p > begp) 
             *cfoll = 128 | (p - begp);
      else
             clead--;                           /* don't need count position */

      return((int)(clead - bufto));             /* how many stored as encoded */
}
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Troubleshooting

This appendix lists some common error messages reported by NCSA Telnet for the Macintosh® 
and their causes.

New Error Messages

With NCSA Telnet 2.6, a new error message system has been implemented. The majority of the 
error conditions NCSA Telnet can encounter are now presented to the user via more verbose modal
dialog boxes. A few error conditions may still be presented via the former error message system, 
which is detailed in the section "Old Style Error Messages" in the chapter.

Each of the new style error modal dialog boxes includes the fields "Internal error #" and "MacOS 
error #." When reporting a problem or possible bug to NCSA, please include these numbers in 
your communication, if possible. These numbers are presented to help us help you track down the 
cause of the problem you are experiencing. If these numbers are zero, NCSA Telnet was unable to 
provide more detailed information than the message given.

Non-Fatal Errors
When a non-fatal error occurs, NCSA Telnet will present a modal dialog box similar to the 

following:

Non-fatal errors occur most often when an action you requested has failed due to insufficient 
memory, a corrupted file, or some other reason. In this case, the user tried to load a set file that is 
corrupted.

The following problems can currently cause non-fatal errors: out of memory, corrupted set files, 
unable to open or create a capture file.

Semi-Fatal Errors
Semi-fatal errors are errors which NCSA Telnet can attempt to remedy, but if the remedy fails 
NCSA Telnet must quit. When such an error occurs, you are presented with a modal dialog similar 

to the following: 

This dialog allows the user to abort any recovery process NCSA Telnet may attempt before it is 
attempted. Selecting Quit will cause NCSA Telnet to quit immediately. 
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Selecting Repair instructs NCSA Telnet to attempt to repair the damage. However, selecting Repair
will not always work, and may just lead to a fatal error condition.

The following condition can currently cause semi-fatal errors: corrupted preferences file.

Fatal Errors
Fatal errors are errors from which NCSA Telnet cannot recover from and thus must quit 
immediately. When such an error occurs, a modal dialog box similar to the following will be 

presented:

In the case of a fatal error, the only option available is Quit.

The following conditions can currently cause fatal errors: no HFS filesystem, system version is not
at least 6.0, lack of 128K ROMs, cannot open MacTCP, cannot create preferences file, corrupted 
NCSA Telnet application file (resources missing), or unable to repair a corrupted preferences file.

Old Style Error Messages

Not all of the error messages in NCSA Telnet 2.6 have been converted to the new error reporting 
system. The following is a list of some old style error messages you may see and a description of 
what they mean:

Couldn’t get translation resource for national character set

A resource is missing from the NCSA Telnet application. Replace your copy of NCSA Telnet from 
a backup or download a new copy.

Translation resource is corrupted

A resource is missing from the NCSA Telnet application. Replace your copy of NCSA Telnet from 
a backup or download a new copy.

Error deleting old file

An error occurred when the FTP server attempted to overwrite a file on the local disk during a file 
transfer.

Error in Sfwrite

An error occurred when the FTP server attempted to write to the local disk during a file transfer.

Disk Full Error

The FTP server ran out of disk space when trying to transfer a file to the local disk.

Host or gateway not responding

This error used to be a catch-all for nearly any error related to connecting to a host. This error will 
now only be produced if the host you are trying to contact does not respond, or if a host you were 
connected to stops responding. Some possible causes of this problem include: accidentally 
unplugging your machine from the network, the remote host lost power or its network connection, 
or your local gateway or internet connection has gone down.
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VT Compatibility and Escape Codes

This appendix lists the features and modes of the VT standard that are not supported by NCSA 
Telnet for the Macintosh®. This appendix also lists the escape codes sent by NCSA Telnet for 
certain codes in the various emulation modes. This appendix is intended as a reference of NCSA 
Telnet’s implementation of VT emulation, and is not intended to be the definitive source for 
information regarding the VT series of terminals.

VT Compatibility

NCSA Telnet does not support double height or double width characters. NCSA Telnet also does 
not support the VT52 mode.

Key Mapping

NCSA Telnet does not emulate the following VT-200 keys: F1, F2, F3, F4, and F5.

NCSA Telnet maps F6 through F20 on the VT-200 keyboard to F1 through F15 on the Apple 
Extended Keyboard.

NCSA Telnet maps PF1 through PF4 on the VT-200 keyboard to the top row of keys on the 
numeric keypad (CLEAR, =, /, *).

Key Codes sent by NCSA Telnet

NCAS Telnet always sends the CSI and SS3 control characters using their 7-bit extensions. 
Therefore, substitute ESC [ (1B 5B) for CSI and ESC O (1B 4F) for SS3 in the following tables.

This section divides the keycode tables by the divisions used in the VT 200 manual.

Editing Keys
Key  (VT Key Name)      VT200 mode            VT100 mode
HELP (find)             9B 31 7E              
                       CSI 1 ~               
HOME (Insert Here)      9B 32 7E              Telnet will send the VT220
                       CSI 2 ~               codes for these keys while in
PAGEUP (Remove)         9B 33 7E              VT100 mode, even though these
                       CSI 3 ~               keys did not exist on the VT100.
DEL (Select)            9B 34 7E            
                       CSI 4 ~
END (Prev Screen)       9B 35 7E
                       CSI 5 ~
PAGEDOWN (Next Screen)  9B 36 7E
                       CSI 6 ~

Cursor Control Keys
Cursor Control Keys (Same for VT200/100)
           Reset                Set        <- Cursor Key Mode
Key         Normal mode          Application mode
UpArrow     9B 41                8F 41
           CSI A                SS3 A
DownArrow   9B 42                8F 42
           CSI B                SS3 B
RightArrow  9B 43                8F 43
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           CSI C                SS3 C
LeftArrow   9B 44                8F 44
           CSI D                SS3 D

Auxiliary Keypad Codes
Auxiliary Keypad Codes    (Same for VT200/100)
           Keypad              Keypad
Key         Numeric mode        Application mode
0           30                  8F 70
           0                   SS3 p
1           31                  8F 71
           1                   SS3 q
2           32                  8F 72
           2                   SS3 r
3           33                  8F 73
           3                   SS3 s
4           34                  8F 74
           4                   SS3 t
5           35                  8F 75
           5                   SS3 u
6           36                  8F 76
           6                   SS3 v
7           37                  8F 77
           7                   SS3 w
8           38                  8F 78
           8                   SS3 x
9           39                  8F 79
           9                   SS3 y
-           2D                  8F 6D
           -                   SS3 m
+ (,)       2C                  8F 6C
           ,                   SS3 l
.           2E                  8F 6E
           .                   SS3 n
Enter       **                  8F 4D
           **                  SS3 M
Clear (PF1) 8F 50               8F 50
           SS3 P               SS3 P
= (PF2)     8F 51               8F 51
           SS3 Q               SS3 Q
/ (PF3)     8F 52               8F 52
           SS3 R               SS3 R
* (PF4)     8F 53               8F 53
           SS3 Q               SS3 Q
           

Top-Row Function Keys
Key    (VT Key Name)    VT200 Mode Code   VT100 Mode Code
F1 (F6)                 9B 31 37 7E
                       CSI 1 7 ~
F2 (F7)                 9B 31 38 7E
                       CSI 1 8 ~         Telnet will send the VT220
F3 (F8)                 9B 31 39 7E       codes for these keys while in
                       CSI 1 9 ~         VT100 mode, even though these
F4 (F9)                 9B 32 30 7E       keys did not exist on the VT100.
                       CSI 2 0 ~
F5 (F10)                9B 32 31 7E
                       CSI 2 1 ~
F6 (F11)                9B 32 33 7E
                       CSI 2 3 ~
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F7 (F12)                9B 32 34 7E
                       CSI 2 4 ~
F8 (F13)                9B 32 35 7E
                       CSI 2 5 ~
F9 (F14)                9B 32 36 7E
                       CSI 2 6 ~
F10 (F15/Help)          9B 32 38 7E
                       CSI 2 8 ~
F11 (F16/Do)            9B 32 39 7E
                       CSI 2 9 ~
F12 (F17)               9B 33 31 7E
                       CSI 3 1 ~
F13 (F18)               9B 33 32 7E
                       CSI 3 2 ~
F14 (F19)               9B 33 33 7E
                       CSI 3 3 ~
F15 (F20)               9B 33 34 7E
                       CSI 3 4 ~
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Obtaining NCSA Software

This appendix outlines the procedures for obtaining NCSA Telnet for the Macintosh® via 
anonymous FTP, an archive server, or U.S. mail.

Anonymous FTP

If you are connected to the Internet (NSFNET, ARPANET, MILNET, etc.) you can download 
NCSA Telnet for the Macintosh software and documentation at no charge from an anonymous File 
Transfer Protocol (FTP) server at NCSA. Follow the steps enumerated below. If you have any 
questions regarding the connection or procedure, consult your local system administrator or 
network expert.

Log on to a host at your site that is connected to the Internet and is running software supporting the
FTP command.

Invoke FTP (on most systems) by entering the Internet address of the server:

%  ftp  ftp.ncsa.uiuc.edu     or     %  ftp  141.142.20.50

Log on by entering anonymous for the name.

Enter your local login name and address (e.g., uldhmi@ncsa.uiuc.edu) for the password.

Enter get README.FIRST to transfer the instructions file (in ASCII) to your local host.

Enter quit to exit FTP and return to your local host.

Review the README.FIRST file for complete instructions concerning the organization of the FTP 
directories and the procedures you should follow to download the README files specific to 
the application you want.

Your logon session should resemble the following sample, where the remote user's name is 
uldhmi@ncsa.uiuc.edu and user entries are indicated in boldface type.

%  ftp ftp.ncsa.uiuc.edu
Connected to zaphod.
220 zaphod FTP server (Version 6.23 Thu Apr 8 06:37:40 CDT 1993) ready.
Name (ftp.ncsa.uiuc.edu: uldhmi):  anonymous
331 Guest login ok, send ident as password.
Password:  uldhmi@ncsa.uiuc.edu
230 Guest login ok, access restrictions apply.
ftp>  get README.FIRST
200 PORT command successful.
150 Opening ASCII mode data connection for README.FIRST (10283 bytes).
226 Transfer complete.
local:  README.FIRST  remote:  README.FIRST
11066 bytes received in .34 seconds (32 Kbytes/s)
ftp>  quit
221 Goodbye.
%

The README.FIRST file instructs you to copy the NCSA Telnet Mac README file to your 
directory and to read it before proceeding. Your FTP session should resemble the one listed below:

ftp> cd Mac/Telnet
250 CWD command successful.
ftp> get README
200 PORT command successful.
150 Opening ASCII mode data connection for README (10283 bytes)
226 Transfer complete.
local:  README  remote:  README
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2080 bytes received in .14 seconds (15 Kbytes/s)
ftp> quit
221 Goodbye.
%

The README file explains how to copy the contents of the NCSA Telnet Macintosh directory to 
your home directory via remote log on or anonymous FTP. The precise file transfer procedure 
varies according to the type of operating system (UNICOS or other OS) under which you use 
NCSA Telnet for the Macintosh®. 

Archive Server

To obtain NCSA software via an archive server:

Email a request to archive-server@ncsa.uiuc.edu.

Include the word help in the subject or message line.

Press RETURN.

Send another email request to archive-server@ncsa.uiuc.edu.

Include the word index in the subject or message line.

Press RETURN.

For example, if you use the UNIX mailing system, your log on session should resemble the 
following sample, where user entries are indicated in boldface type.

% mail archive-server@ncsa.uiuc.edu
Subject:  help
.
EOT
Null message body; hope that's ok
% mail archive-server@ncsa.uiuc.edu
Subject:  index
.
EOT
Null message body; hope that's ok

The information you receive from the help and index commands gives you further instructions on 
obtaining NCSA software. This controlled-access server emails the distribution to you one 
segment at a time.

Mail

NCSA Telnet for the Macintosh® software and manuals are available for purchase, either 
individually or as part of anonymous FTP reel or cartridge tapes, through the NCSA Technical 
Resources Catalog. All orders prepaid. To obtain a copy of the catalog, contact NCSA Orders by 
electronic mail at orders@ncsa.uiuc.edu, by phone at (217) 244-4130, or by U.S. mail at:

NCSA Orders

152 Computing Applications Building

605 East Springfield Avenue

Champaign, IL  61820-5518
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